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Upute za izradu vježbi/zadataka 

Za izradu vježbe koristi se program za izradu crteža i dijagrama MS Office Visio te program za izradau 
prezentacija MS PowerPoint. Prije dolaska na vježbu potrebno je izraditi pripremu. Bez napravljene 
pripreme nije moguće pristupiti izradi vježbi. Nakon izrade vježbu je potrebno: 

1. Pokazati asistentu/demonstratoru. Netočno i nepotpuno izrađena vježba NEĆE biti priznata 
kao odrađena! 

2. Pohraniti kao datoteku s nazivom datoteke u slijedećem obliku –  
JMBAG_GRUPA_GGGG-MM-DD_VJEŽBE# te datoteke sa vježbe komprimirati tako da se 
odaberu obje datoteke te se nakon klika desne tipke miša odabere opcija „send to > 
compressed folder“ 

Vrijeme za izradu laboratorijske vježbe iznosi 90 minuta.  

Cilj vježbe:  Upoznavanje sa grafičkim okruženjem programa za crtanje MS Visio. Izrada 
dijagrama toka, odabir grafičkih simbola iz izbornika simbola, povezivanje i samo-
povezivanje simbola, izrada blokovskih shema i skica. Upoznavanje sa programom 
za izradu grafičke prezentacije MS PowerPoint. Kreiranje nove multimedijalne 
stranice, odabir predloška, odabir pozadine, te animiranje objekata na stranici. 

5.1 Opis dijela vježbe MS Visio 
Microsoft Visio je program za crtanje programskih, poslovnih i prezentacijskih crteža i dijagrama, kao 
što su dijagrami toka, organizacijski dijagrami, mrežni dijagrami i slični grafički prikazi. U vježbi ćete se 
upoznati s osnovama crtanja i uređivanja crta i likova te sa izradom dijagrama toka i blokovskih 
shema te skica. 

5.1.1 Uvod u MS Visio 
Program se pokreće tako da se u izborniku „Start->Programs“ pronađe ikona programa MS Visio 
aktiviranjem koje se program pokreće. Nakon otvaranja programa ponuđeni su predlošci i simboli 
objekata za crtanje razvrstani u skupine prema zadacima koji se žele izvršiti, npr. predlošci sa 
simbolima za crtanje dijagrama toka, mrežne infrastrukture, UML dijagrama i slično. Aktiviranjem 
ikone pojedine skupine otvara se predložak s odgovarajućim simbolima. Za potrebe crtanja dijagrama 
toka izvođenja programa, potrebno je aktivirati skupinu Flowchart (Dijagram toka) preko „File-
>Shapes->Flowchart->Basic Flowchart Shapes“ (Metric), slika 5.1.1. Grafičko sučelje sastoji se od 
Naslovnog reda, trake izbornika, trake s alatima, Radne površine odnosno Radnog lista te različitih 
oblika/simbola koji se koriste za prikaz dijagrama toka, a u skladu s odabranom skupinom, slika 5.1.2. 
 
Prikaz i uklanjanje trake s alatima izvodi se kao i u ostalim programima iz paketa MS Office. Pritisak 
na desnu tipku miša na traci s alatima otvora izbornik u kojem se odabire traka s alatima koji se žele 
prikazati odnosno prikazanu traka s alatima koja se žele ukloniti, slika 6.1.3. Odabrana traka s alatima 
prikazuje se iznad radnog lista. Traka s alatima se pomiče tako da se pokazivač postavi u Naslovni 
redak trake s alatima, pritisne se i zadrži pritisnutom lijeva tipka miša te se traka s alatima povuče na 
mjesto gdje se želi postaviti. Osim na Radnom listu traka s alatima se može smjestiti pored ostalih 
traka s alatima. 

 

Kolegij Računalstvo | Datum:   
Vježba # 5 | tema: MS Office Visio i PowerPoint 
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Slika 5.1.1 Otvaranje alata i simbola za crtanje dijagrama toka  

Različitih oblici simbola 
za prikaz dijagrama toka

Vrpca izbornika
Radna površina Vrpca s alatima 

(Drawing)

 
Slika 5.1.2 Opis grafičkog sučelja programa MS Visio 
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Slika 5.1.3 Prikaz trake s alatima 
 
Umetanje nove stranice je slično kao u programu MS Excel. Preko izbornika Insert (Umetni) odabirom 
umetanje nove stranice Insert -> New Page ili postavljanjem pokazivača na naziv stranice na donjem 
dijelu stranice i pritiskom na desnu tipku miša otvara se izbornik u kojem se odabire Insert Page 
(Umetni stranicu), slika 5.1.4.. Pri tome se otvara dijaloški okvir u kojem je moguće zadati određene 
postavke stranice, kao što je npr. naziv stranice (engl. „Name“). Potvrda otvaranja stranice s zadanim 
postavkama ostvaruje se pritiskom na tipku OK (Prihvati). Za poništenje pritisnuti tipku Cancel 
(Poništi). Za brisanje postojeće stranice odabire se Delete Page (Izbriši stranicu), a za promjenu naziva 
stranice „Rename Page“ (Promjeni naziv stranice). Za potvrdu promjene naziva stranice dovoljno je 
pritisnuti tipku „Enter“ na tipkovnici.  
 

 
Slika 5.1.4. Umetanje nove stranice 
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5.1.2 Osnove crtanja i umetanja objekata 

 

Slika 5.1.5.  Svi alati trake za crtanje (engl. „Drawing“) 

5.1.3 Crtanje linija, lukova i krivulja  
Za crtanje crta, lukova i krivulja koriste se alati u traci s osnovnim alatima za crtanje (engl. 
„Drawing“). Za crtanje crte potrebno je u traci s osnovnim alatima za crtanje (engl. „Drawing“) 
odabrati alat za crtanje crta (engl. „Line Tool“) i postaviti ga iznad radnog lista na mjesto početne 
točke crte. Pritiskom i zadržavanjem desne tipke miša pokazivač se povlači do mjesta krajnje točke 
crte, gdje se desna tipka miša otpušta. Na taj način crta je nacrtana. Ako se želi pomaknuti početak ili 
kraj crte na neko drugo mjesto, potrebno je pritisnuti lijevom tipkom miša na krajnju točku crte, 
zadržati pritisnutu tipku, te povući na mjesto na koju se želi postaviti krajnja točka crte. Otpustiti 
tipku miša nakon čega se može nastaviti s crtanjem. Pomicanje crte se postiže odabirom alata za 
odabir (engl. „Pointer Tool“). Pokazivač se postavlja iznad crte koja se želi pomaknuti, pritisnuti i 
zadržati lijevu tipku miša te povući crtu na mjesto na koje se želi premjestiti, te potom otpustiti tipku 
miša.  
 
Za crtanje luka potrebno je u traci s osnovnim alatima za crtanje (engl. „Drawing“) odabrati alat za 
crtanje lukova (engl. „Arc Tool“) i postaviti ga iznad radnog lista na mjesto početka luka. Pritiskom i 
zadržavanjem desne tipke miša pokazivač se povlači do mjesta krajnje točke luka, gdje se desna tipka 
miša otpušta. Na taj način luk je nacrtan. Luk ima početnu i krajnju točku te točku pomoću koje je 
moguće promijeniti nagib luka.  
 
Osim crta i lukova program omogućava i crtanje krivulja. Za crtanje krivulje potrebno je u traci s 
osnovnim alatima za crtanje (engl. „Drawing“) odabrati alat za crtanje krivulja (engl. „Freeform Tool“) 
i postaviti ga iznad radnog lista na mjesto početka krivulje. Pritiskom i zadržavanjem desne tipke miša 
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pokazivač se povlači i pri tome se iscrtava krivulja koja se sama oblikuje kako bi izgladila oštre rubove. 
Tako se dobiva osnovni izgled krivulje koji je kasnije moguće dodatno oblikovati. Ako želimo zatvoriti 
krivulju kako bi dobili lik potrebno je krajnju točku krivulje postaviti iznad početne točke krivulje. 
Zatvorenom liku dodijeljena je boja, tj. nacrtani lik je obojen. Ako se krajnja točka krivulje ne postavi 
iznad početne točke krivulje dobiva se otvorena krivulja.  

5.1.4 Crtanje pravokutnika, kvadrata i krugova 
Za crtanje pravokutnika potrebno je u traci s osnovnim alatima za crtanje (engl. „Drawing“) odabrati 
alat za crtanje pravokutnika (engl. „Rectangle Tool“) i postaviti ga iznad radnog lista na mjesto 
početnog vrha pravokutnika. Pritiskom i zadržavanjem desne tipke miša pokazivač se povlači do 
mjesta dijagonalno suprotnog vrha pravokutnika, gdje se desna tipka miša otpušta. Na taj način 
pravokutnik je nacrtan.  
 
Ako se želi nacrtati kvadrat postupak je jednak postupku crtanja pravokutnika samo što se kod 
crtanja početnog vrha treba držati pritisnuta i tipka za mijenjanje malih/velikih slova (engl. „Shift“). 
Za pomak pravokutnika ili kvadrata potrebno je postaviti pokazivač iznad pravokutnika ili kvadrata, te 
pritisnuti i zadržati pritisnutom lijevu tipku miša do mjesta gdje se lik želi preseliti. Otpustiti tipku 
miša.  
 
Za crtanje kruga ili elipse potrebno je u traci s osnovnim alatima za crtanje (engl. „Drawing“) odabrati 
alat za crtanje elipse (engl. „Ellipse Tool“) i postaviti ga iznad radnog lista na mjesto gornje lijeve 
točke kružnice. Pritiskom i zadržavanjem desne tipke miša pokazivač se povlači do mjesta dijagonalno 
suprotnog početnoj točki, gdje se desna tipka miša otpušta. Na taj način nacrtana je elipsa. Ako se 
želi nacrtati krug postupak je jednak postupku crtanja elipse samo što se prije početka crtanja 
početne točke treba držati pritisnuta i tipka za mijenjanje veličine slova (engl. „Shift“). 

5.1.5 Postavke povlačenja i lijepljenja 
Približavanjem likova vidi se da između njih postoji razmak, tj. likovi se ne dodiruju. To je posebno 
vidljivo ako se poveća prikaz radne stranice. Povećanje prikaza radne stranice se ostvaruje 
korištenjem padajućeg izbornika Zoom u standardnoj alatnoj traci gdje se odabire iznos povećanja 
radne stranice. Drugi način povećanja prikaza radne stranice je pritiskom tipke Ctrl na tipkovnici i 
vrtnjom „valjka“ na mišu. Dozvoljeni razmak između objekata na stranici se postavlja korištenjem 
postavki povlačenja (engl. „Snap“) i lijepljenja (engl. „Glue“). Uključivanje ili isključivanje ovih 
postavki se postiže odabirom „Snap & Glue ...“ pod Alati (engl. „Tools“) u traci izbornika. Isključivanje 
postavki Snap & Glue ... u prozoru općih postavki pod „General“ i „Currently active“ omogućuje 
slobodno pomicanje objekata. 
 

5.1.6 Umetanje simbola određene skupine objekata 
Za umetanje ponuđenih oblika (engl. „Shapes“) uz određenu skupinu objekata potrebno je 
postavljanjem pokazivača na simbol u izborniku oblika pritiskom na lijevu tipku miša odabrati simbol 
koji se želi postaviti na radnu stranicu i povlačenjem postaviti na mjesto radne stranice gdje ga se želi 
smjestiti. Otpustiti tipku miša nakon čega je željeni oblik umetnut. 

5.1.7 Promjena veličine i zakretanje objekata 
Za promjenu veličine oblika potrebno je postaviti pokazivač na željeni oblik i pritiskom na lijevu tipku 
miša odabrati oblik, te postaviti pokazivač na vršne točke, hvataljke (engl. „Resize Shape“), oblika i 
pritiskom na lijevu tipku miša razvući oblik do željene veličine. Otpustiti tipku miša. 
 
Za zakretanje odabranog oblika na radnoj stranici potrebno je pokazivač postaviti na hvataljku za 
zakretanje (engl. „Rotate Shape“) i zakretanjem u jednom ili drugom smjeru provesti zakretanje. 
Hvataljka za zakretanje se nalazi na iznad odabranog oblika. Na isti način moguće je promijeniti 
veličinu i zakrenuti prethodno nacrtane likove.  
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5.1.8 Premještanje, preslikavanje i odabir objekata 
Za premještanje i preslikavanje (kopiranje) objekata potrebno ih je prvo odabrati, a što se postiže 
alatom za pokazivanje (engl. „Pointer Tool“) koji se nalazi na traci sa standardnim alatima, slika 5.1.6.. 
Odaberemo objekt pritiskom na lijevu tipku miša. Istovremeni odabir više objekata postiže se 
pritiskom tipke Shift na tipkovnici i njezinim zadržavanjem prilikom odabira ostalih objekata. Odabir 
objekata moguće je odabrati i korištenjem ostalih alata uz alat za pokazivanje (engl. „Pointer Tools“). 
Ostali alati se prikazuju i odabiru tako da se pritisne na znak trokuta uz alat pokazivača te se odabere 
jedan od alata za izbor objekata.  
 
Za premještanje i preslikavanje objekata koriste se alati za preslikavanje (engl. „Copy“) i 
odbacivanje/rezanje (engl. „Cut“) koji se pokreću preko trake izbornika slijedom Edit->Copy odnosno 
Edit->Cut, dok se za postavljanje preslika lijepljenje (Paste) objekata slijedom Edit->Paste. Ovi alati se 
mogu koristiti tek nakon odabira jednog ili više objekata. Brži način premještanja objekata ostvaruje 
se pritiskom i zadržavanjem tipke Ctrl na tipkovnici, odabirom objekta ili objekata i zadržavanjem 
lijeve tipke miša pomicanjem objekata na mjesto gdje ih želimo preslikati. Pomicanjem pokazivača s 
odabranim objektom ili objektima po radnom listu pomiču se i preslike objekata. Nakon 
pozicioniranja objekata otpušta se tipka miša nakon čega su objekti kopirani. Za uklanjanje okvira za 
odabir objekata potrebno je potrebno je pritisnuti lijevu tipku miša bilo gdje na radnom listu. 

 
Slika 5.1.6 Uređivanje i kopiranje objekata 

 

5.1.9 Formatiranje crta i krivulja 
Uz svaki objekt su vezana određena svojstva, kao npr. debljina ili boja crte i slično. Svojstva objekta se 
mogu prilagoditi odabirom objekta i u skladu s potrebama se preko izbornika Format u traci s 
izbornicima odabere jedan od alata za formatiranje vezan uz svojstva odabranog objekta. Za 
formatiranje, tj. promjenu svojstava crte ili krivulje odabire se „Line ...“. Isti rezultat se postiže ako se 
nakon odabira objekta pritiskom na desnu tipku miša odabere Format.  
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Tako se npr. za mijenjanje pune crte u isprekidanu odabirom Line otvara dijaloški okvir Line i u 
padajućem popisu pod uzorci (engl. „Pattern“) preko znaka trokuta odabere jedan od isprekidanih 
uzoraka. U istom se dijaloškom okviru odabiru i debljina (Weight), boja (Color), oblik i veličina (Begin 
size, End size) izgleda strelice na početku (Begin) i kraju (End) crte. Pritiskom na tipku primjeni (Apply) 
i pomakom dijaloškog okvira kako bi se vidio izgled novo pridruženog svojstva. Krajnja potvrda 
prihvata odabranog svojstva se postiže tipkom OK. Za uklanjanje okvira za odabir objekta pritisnuti 
bilo gdje na radnom listu. 
 

 
Slika 5.1.7. Okvir za formatiranje crta i krivulja 

5.1.10 Formatiranje likova 
U radu s likovima moguće je mijenjati boju ruba i površine lika tako da se nakon odabira lika izbornika 
Format na dijaloškom okviru Line pod bojom (Color ...) odabere boja ruba lika. Za bojanje površine 
lika nakon odabira lika pod Format odabere bojanje (Fill ...). U dijaloškom okviru Fill odabiru se boja 
(Color) i uzorak (Pattern) površine lika. Istovremena promjena svojstava više objekata postiže se na 
isti način pri čemu se prije formatiranja odaberu objekti kojima se žele postaviti ista svojstva. 
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Slika 5.1.8. Formatiranje ispune lika 

 
Likovima je moguće mijenjati izgled vrhova i stranica. Za promjenu vrhova lika potrebno je alatom za 
pokazivanje (Pointer Tool) odabrati lik te preko Format pod Line odabrati zaobljenost vrha (Round 
corners) lika. Za preoblikovanje izgleda stranica potrebno je odabrati lik, zadržati pokazivač dok se ne 
pojave hvataljke čijim potezanjem u željenom smjeru se mogu oblikovati stranice. 

5.1.11 Promjena oblika nacrtanog objekta 
Oblik nacrtanog objekta se mijenja na način da se alatom za pokazivanje (Pointer Tools) sa 
standardne alatne trake odabere željeni objekt pri čemu se iznad objekta pokazuju hvataljke (točke) 
pomoću kojih možemo promijeniti oblik prikazane krivulje. Tako se npr. u slučaju promjene oblika 
krivulje odabirom pojedine hvataljke pritiskom i držanjem lijeve tipke miša i njegovim pomicanjem 
mijenja zakrivljenost odnosno oblik krivulje. Nakon otpuštanja tipke miša krivulja poprima novi izgled. 

5.1.12 Osnove rada s tekstom 
Često puta je crteže i dijagrame potrebno opisati ili im dodati tekst. U ovoj vježbi se pokazuju 
postupci umetanja, formatiranja i pridruživanja teksta objektima. 

5.1.13 Umetanje i formatiranje teksta 
Tekst se umeće na način da se odabere alat za pisanje teksta s trake s alatima i pokazivač postavi na 
radnom listu iznad mjesta gdje se želi unijeti tekst te se potom u okvir upiše željeni tekst. Nakon 
upisa pritisnuti lijev tipku miša bilo gdje na radnom listu,a nakon čega se tekst pojavljuje na radnom 
listu. 
Za formatiranje teksta potrebno ga je odabrati korištenjem alata za pokazivanje (Pointer Tool). 
Formatiranje se provodi korištenjem mogućnosti koje nudi traka s alatima za formatiranje (npr. 
odabir vrste, veličine ili boje slova), kao što je to slučaj i kod ostalih programa iz paketa MS Office 
(npr. MS Word). 
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Tekst je moguće i zakrenuti korištenjem hvataljke za okretanje teksta, koja se uz ostale hvataljke 
pojavljuju kada se tekst odabere. Tekst se zakreće njezinim držanjem lijevom tipkom miša i 
zakretanjem do željenog kuta kada otpuštanjem tipke miša tekst bude postavljen u željeni smjer. 

 
Slika 5.5.1.Kreiranje tekstualnog okvira 

5.1.14 Pridruživanje teksta objektima 
Tekst je moguće pridruživati i prethodno nacrtanim objektima nezavisno da li se radi o crtama ili 
likovima. U slučaju kada se tekst želi upisati u prethodno nacrtani lik potrebno je odabrati lik i alat za 
pisanje teksta (engl. „Text Tool“). Nakon poziva alata za pisanje teksta omogućen je unos teksta u 
odabrani objekt. Nakon unosa teksta završetak unosa se postiže pritiskom lijeve tipke miša na bilo 
koje mjesto radnog lista. U objekt je upisan tekst koji se u slučaju pomaka teksta pomiče s njime. 

5.1.15 Crtanje dijagrama toka 
Programski alat MS Visio moguće je koristiti i za grafičko crtanje dijagrama toka. Pri tome napravljeni 
dijagram toka služi kao dokumentacija odnosno nije moguće njegovo izvršavanje. 
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5.1.16 Povezivanje likova 

Nepovezane likove možemo međusobno povezivati odabirom alata za povezivanje (engl. „Connector 
Tool“), a zatim pritisnemo lijevu tipku mišu na jednu od spojnih točaka lika, te vučemo do spojne 
točke nekog drugog lika. U slučaju da je alat povezivanje ostao aktivan, prilikom stavljanja novog lika, 
spajanje je automatsko. 

Slika 5.1.9. Upotreba alata za povezivanje 
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5.2 Opis dijela vježbe MS PowerPoint 
Microsoft PowerPoint je program koji služi za izradu grafičkih prezentacija u obliku multimedijalnih 
stranica. Projekti, ideje i proizvodi mogu se primateljima predočiti na različite načine, te kada je riječ 
o računalnoj prezentaciji, PowerPoint će omogućiti istu na vrlo uvjerljiv i vizualno privlačan način. 
Slika vrijedi tisuću riječi, a multimedija milijun. Prezentacija se sastoji od niza stranica, a stranice 
mogu činiti tekstovi, crteži, videozapisi, fotografije, audiozapisi i svi ostali multimedijalni elementi. 
Gotova prezentacija se može prikazati gledateljima na dva načina: 

a) Multimedijalni prikaz na projektoru sa svim audio vizualnim elementima; 
b) Otisnuto na papiru radi učenja ili kasnijeg ponavljanja; 

Nakon otvaranja nove prezentacije potrebno je odabrati temu same prezentacije u „Design“, 
„Themes“ (slika 5.2.1.). Preporučuje se odabir teme sa svjetlijom pozadinom radi bolje preglednosti i 
kontrasta na projektoru, jer prezentacije pred većim brojem ljudi će biti izvedene uz dnevnu rasvjetu 
ili rasvjetu u prostoriji što će jako umanjiti kontrast slike. 

Nakon što smo odabrali temu i eventualno promijenili pozadinu prezentacije pod „Design“, 
„Background Styles“, za svaku stranicu (engl. „slide“), izabirete njezin izgled. Otvaranje nove stranice 
je prikazano na slici 5.2.2. te odabir izgleda stranice na slici 5.2.3. 

Odaberite sliku sa opisom (engl. „Picture with caption“) za novu stranicu kako je to prikazano na slici 
5.2.3. 

 
Slika 5.2.1. Odabir teme kao predloška za prezentaciju 
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Slika 5.2.2. Dodavanje nove stranice (engl. „slide“) 

 
Slika 5.2.3. Odabir izgleda odnosno oblika trenutne stranice 

Potrebno je odabrati i postaviti neku sliku, te radi ljepšeg izgleda moguće je odabrati efekt odnosno 
način prikazivanja slike („Format>Picture Styles“) kako je prikazano na slici 5.2.4. Vrlo dobar izvor 
slika je „Google“ pretraživač slika, no pazite na autorska prava kada koristite slike sa Interneta. 
Najbolje je navesti kraj slike kratku informaciju od kuda je slika preuzeta.  
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Slika 5.2.4. Umetanje slike i odabir efekta ili stila prikazivanja slike 

Kako bi prezentacija dodatno oživjela te dodatno privukla pažnju slušača prezentacije, moguće je 
koristiti animacije objekata korištenjem izbornika „Animation“. Izaberite objekt koji želite animirati te 
način animacije kako je prikazano na slici 5.2.5. 

 
Slika 5.2.5. Animiranje objekata na stranici i otvaranje panela za napredno uređivanje 
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Kako je vidljivo sa slike 5.2.5. nakon odabira animacije 
slike, pojavi se narančasti kvadratić sa brojem 1. Nakon 
izmjene opcije „Start with previous“, broj će preći u 
broj 0, što znači da se animacija započinje odmah po 
otvaranju te stranice. Dodajte još jednu animaciju na 
objekt slike odabirom „Add Animation“ i pod grupom 
„Exit>Fade“ prema slici 5.6. Na panelu animacija 
pojavljuje se nova animacija (slika 5.2.7.). 

Na zadnju stranicu postavite zahvalu slušačima 
prezentacije na vremenu i pažnji koji su posvetili vašoj 
prezentaciji (slika 
5.2.8.). 

Prezentacija se 
pokreće tipkom 
„F5“ ili klikom na 

. 

 

 
 

 

    Slika 5.2.6. Dodavanje izlazne animacije          
Slika 5.2.7. Prikazi svih animacija na stranici 

 
Slika 5.2.8. Zadnja stranica bi trebala biti zahvala na financiranju ako se radi o prezentaciji rada ili 

zahvala slušačima na sudjelovanju 
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5.3 Priprema za vježbu 
- Odraditi vježbe upoznavanja s programima MS Office Word i MS Office Excel iz programskog 

paketa Microsoft Office. 
- Popuniti sljedeću tablicu i pokazati dežurnom asistentu na početku vježbe. 

Napomena: 

Pripremu za laboratorijsku vježbu je potrebno napisati vlastoručno na ovom papiru. Student koji 
prilikom ulaska u dvoranu nema napisanu pripremu nema pravo pristupa laboratoriju i smatra se da 
student nije odradio laboratorijsku vježbu. 

 
Dio Funkcija Opis 
1.) Što se nalazi unutar 

izbornika Shapes? 
 
 
 
 
 
 
 
 

 

2.) Koji se sve geometrijski 
elementi mogu nacrtati 
korištenjem izbornika sa 
alatima za crtanje (engl. 
„Drawing“)? 
 
 
 
 
 
 
 
 

 

3.) Iz kojih je razloga bitan alat 
za povezivanje kod crtanja 
dijagrama toka? 
 
 
 
 
 
 
 
 

 

 
Ime i prezime studenta: 
 
 

Potpis studenta      Potpis dežurnog asistenta 
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5.4 Rad na vježbi 
Rad na vježbi sastoji se od izrade crteža korištenjem alata za crtanje grafičkih prikaza MS Visio. 
 
Zadatak 1. Pokrenuti program MS Visio. Aktivirati skupinu simbola za crtanje dijagrama toka. Otvoriti, 
postaviti u lijevi gornji kut Radnog lista i zatvoriti traku s osnovnim alatima za crtanje (engl. 
„Drawing“). 
 
Zadatak 2. Koristeći prethodne alate precrtati sljedeći dijagram toka prema slici. Algoritam prikazan 
dijagramom toka daje zbroj prvih n prirodnih brojeva. 

 
 
Zadatak 3. Spremite i zatvorite dokument 
 
Prema opisu dijela vježbe MS PowerPoint izradite sljedeće zadatke: 
 

1. Pokrenite MS PowerPoint 
2. Napravite uvodnu, odnosno naslovnu stranicu 
3. Dodajte novu stranicu sa slikom, opisom slike 
4. Animirajte ulaz slike 
5. Animirajte izlaz slike 
6. Dodajte zadnju stranicu 
7. Koristeći „WordArt“ zahvalite se na pažnji gledateljima 
8. Spremite i zatvorite prezentaciju 

 
Označite obje datoteke (Visio dokument i PowerPoint prezentaciju), desni gumb miša i „Send to-> 
Compressed folder“ te pošaljite komprimiranu datoteku na e-student. 


